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Using this Guide 
 
This document contains an overview of the components and terms used in the Benefit-Cost Analysis (BCA) Toolkit Version 6.0, information on how to navigate 
the new Toolkit, and answers to common questions about the new Toolkit. 
 
This document is not intended as a substitute for the E/L 0276: Introduction to Benefit-Cost Analysis course offered through the Emergency Management 
Institute (EMI). This document is designed to guide users who are familiar with FEMA’s Benefit-Cost Analysis Toolkit v.5.3.0 through the components and terms 
used in v.6.0 and to provide an overview of the Toolkit’s functions. 
 
If you are not familiar with the concepts behind BCA, FEMA offers courses and training materials. More information is available at www.fema.gov/benefit-cost-
analysis. If you have questions about any of the terms used in this document, please contact the Benefit-Cost Helpline at bchelpline@fema.dhs.gov.  
  

http://www.fema.gov/benefit-cost-analysis
http://www.fema.gov/benefit-cost-analysis
mailto:bchelpline@fema.dhs.gov
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BCA Toolkit 6.0: User Interface Overview 
 

Platform 
 
The BCA Toolkit 6.0 is built on a Microsoft Excel platform and uses an add-in to perform the BCA calculations. An add-in can be thought of as an “app” within 
Excel that extends the functionality of the program. The add-in only works in the official BCA Toolkit 6.0 Excel template file. 
 

System Requirements 
 
Users must have Excel 2013 or later installed on their machine or may use Excel Online. (Please note that Macintosh users must have Excel 2016 or later as there 
was no Office 2013 release for Mac.) If using a FEMA machine, you must have Office 365. 
 
To use Excel Online, your computer must be connected to the internet and you will need a Microsoft Office 365 account. See the “Excel Online” section in 
Appendix A. Please also see the “File Management” section for important information about saving your project data in Excel Online.  
 

Installation 
 
See Appendix A of this document for installation instructions. 
 
  

https://www.fema.gov/media-library/assets/documents/179903
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Launching 
 

1. Launch the BCA Toolkit by clicking on the FEMA BCA V6.0 icon in the top ribbon under the Home tab. A sidebar entitled “FEMA Benefit-Cost Analysis 
Calculator” should appear on the righthand side of the screen as shown in Figure 1 (this may take a moment if launching for the first time). You may click 
through images on the sidebar for an overview of how to create a project and how to add a new structure or mitigation action to a project. 

2. Click “Open Calculator” to begin your BCA. A new window will open. Click “Add Project” to begin a new BCA. 
3. To save your work, click “Finish” on the second screen, and save the Excel file, renaming it if desired. 

 

 
Figure 1: Launch screen of BCA Toolkit v.6.0 
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Home Screen 
 
The Home screen (see Figure 2) is the main screen you will see after clicking the “Open Calculator” button on the launch screen. From here, you can begin a new 
project, edit or delete an existing project, and import or export projects. If you have previously saved projects in the Excel file, they will appear in the list here. 
 
See the Navigating the Tool section of this guide for more information. 
 

 
Figure 2: Home screen 
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Project Configuration Screen 
 
The Project Configuration screen is the first step in beginning your BCA calculation. On this screen (see Figure 3) you will enter basic information about your 
project, such as your project title, location, property/structure type, and project costs. See the Navigating the Tool section of this guide for more information. 
 

 
Figure 3: Project Configuration screen 
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Hazard Analysis Screen 
 
After clicking “Next” on the Project Configuration screen, the Toolkit will open the Hazard Analysis screen. The “cards” (see “Cards” section below) you see here 
are dependent upon the information you entered on the Project Configuration screen. For example, if you selected Critical Facility as the property type, you will 
see a card with inputs for critical facility type. In order to save your work, you must click “Finish” at the bottom of this screen and then save the Excel file. 
 

Cards 
 
The BCA Toolkit 6.0 data input sections are comprised of “cards.” As shown in Figure 4, these are the bounded boxes seen on both the Project Configuration and 
Hazard Analysis screens and may be thought of as different sections or categories of data inputs. As mentioned above, the cards you see on the Hazard Analysis 
screen are dependent upon the information you entered in the Project Configuration screen. 
 

 
Figure 4: Cards  
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Default Yes/No Toggles 
 
One of the goals in developing Version 6.0 was to reduce the number of manual-input data fields. Where possible, default values have been populated in the 
Toolkit, with the option to switch the toggle to No and enter a custom value (see Figure 5).  
 

 
Figure 5: Default Yes/No toggles 

If a non-default value is used, users should enter a comment in the comment box (see below for more information) and include documentation with their Hazard 
Mitigation Assistance (HMA) project application. See the “Navigating the Toolkit” section of this guide for more information. 
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Comment Boxes 
 
Comment boxes (see Figure 6) are available for any non-default value input or data field that is not automatically calculated. Comment boxes should be used as 
a way for the BCA analyst to tell the BCA reviewer why a certain value was used and to refer the reviewer to the appropriate documentation in the project 
application. See the Navigating the Tool section of this guide for more information. 
 

 
Figure 6: Comment boxes 
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Project Summary Screen 
 
Upon clicking “Finish” on the Hazard Analysis screen, you will see the Project Summary screen (see Figure 7Error! Reference source not found.). From here you 
can add/delete a structure to/from your project, copy a structure, or generate the project report. See the Navigating the Tool section of this guide for more 
information. 
 

 
Figure 7: Project Summary screen 
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Help Content 
 
The Help Content in the BCA Toolkit may be accessed by clicking on the “i” icon at the top of each card as shown in Figure 8. The Help Content is dynamic, 
meaning that the information that appears will depend on which page of the toolkit you are on and which card you clicked on. 
 

 
Figure 8: Help content icon 
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To close the Help content window, make sure you click the inner “x” as shown in Figure 9. Clicking on the other “x” will close the add-in window altogether. 
 

 
Figure 9: Closing the Help content window (may look different in Excel for Mac) 
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Updates 
 
If updates are available, BCA Toolkit 6.0 will automatically update upon reopening if your computer is connected to the internet. You no longer need to manually 
install updates. 
 
Release notes for any future updates may be found at www.fema.gov/benefit-cost-analysis.   

http://www.fema.gov/benefit-cost-analysis
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Analysis Options 
 

Structure Types 
 
The structure type options in v.6.0 are Residential Structure, Non-Residential Structure, Critical Facility, Utilities, and Roads & Bridges. These are the same 
options as in v.5.3.0. The main difference is that users must now select their structure type on the first screen regardless of hazard and analysis methodology, 
instead of answering multiple questions so that the Toolkit can determine the structure type and appropriate analysis methodology. 
 
Critical Facilities and Hurricane Wind/Safe Rooms 
 
To do a BCA for a hurricane safe room for a critical facility, you must select “Non-Residential Building” as the structure type and then select “Hurricane Safe 
Room” as the hazard. This is because the benefits are based not on loss of service of the facility but on injury and loss of life of the people inside the safe room. 
 
When conducting a BCA for a hurricane wind retrofit of a critical facility, there are two options for how to analyze the benefits. The appropriate choice depends 
on whether the project will primarily reduce (1) physical damages to the building or (2) loss of service. If the project primarily reduces physical damages and/or 
loss of function resulting from the physical damages, then the user should select Non-Residential Building for the structure type and use the modeled damages 
approach. If the project’s loss of service reduction is primarily based on reduced service down time instead of improved building performance, then the user 
should select “Critical Facility” as the structure type and use the Historical or Professional Expected Damages methodology.  
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Hazard Options 
 

Hazards in v.5.3.0 Hazards in v.6.0 

Flood 

Riverine Flood 
Coastal A Flood 
Coastal V Flood 
Coastal Unknown Flood 

Hurricane Wind Hurricane Wind 
Hurricane Safe Room Hurricane Safe Room 
Tornado Safe Room Tornado Safe Room 
Earthquake Seismic 
Wildfire Wildfire 
Drought Drought 

N/A 

Landslide 
Dam/Levee Break 
Extreme Temperature 
Infrastructure Failure 
Severe Storm 
Tsunami 
Volcano 
Winter Storm 
Uncategorized 

Table 1: Hazard Options in v.5.3.0 versus v.6.0 

 
Version 6.0 keeps all the same hazards as v.5.3.0 and adds new hazards based on FEMA’s Data Governance Council standards (see Table 1). These new hazards 
must currently be analyzed using either the Historical or Professional Estimated Damages method, which are discussed further below.  
 
Additionally, v.6.0 separates out coastal and riverine flooding. This does not change any of the calculations; the main difference between the various flood 
options is which Depth Damage Functions (DDFs) appear on the Hazard Analysis screen. 
 
If your structure is along a tidal river but not impacted by wave action and you want to account for future relative sea level rise (SLR), you may select “Coastal 
Unknown” to select the applicable DDF and input your SLR information. 
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Analysis Methodology 
 

 
Figure 10: Analysis Methodology Differences between v.5.3.0 and v.6.0 

None of the calculations or analysis methods have changed from v.5.3.0 to v.6.0. The same information is required for a drainage project or a hurricane wind 
retrofit regardless of which version of the Toolkit you use. The way these analysis types are configured within the Toolkit has changed, however.  
 
The Damage Frequency Assessment (DFA) method is no longer a stand-alone module but is now contained within every hazard option as two separate analysis 
methods, based on the available data. The different methodologies, how to select or switch between them, the project options for each methodology, and the 
data needed for each are covered in the following sections. 
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“Full Data” Hazard Modules vs. Modeled Damages 
 
What used to be known as the “full data” hazard modules (e.g. Long-Form Flood, Hurricane Wind, etc.) in previous iterations of the Toolkit are now consolidated 
as the “Modeled Damages” approach. The availability of this approach depends on the hazard and structure type selected. For example, the Modeled Damages 
approach is available for a residential structure acquisition in the riverine flood hazard but is not available for a utilities or road drainage project. A utilities-based 
drought mitigation project, however, could be completed using modeled damages. 
 
All the project types that previously used the full data modules can be analyzed using the Modeled Damages approach. For residential structures, non-residential 
structures, and critical facilities, Modeled Damages is the default damage frequency approach. Figure 11, Figure 12, Figure 13, and Figure 14 on the following 
pages show which hazards are available for these structure types. 
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Figure 11: Hazards available for Residential Building using the Modeled Damages methodology 
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Figure 12: Hazards available for Non-Residential Building using the Modeled Damages methodology 
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Figure 13: Hazards available for Critical Facility using Modeled Damages methodology 
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Figure 14: Hazards available for Utilities using the Modeled Damages methodology 
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Damage Frequency Assessment vs. Historic/Professional Estimated Damages 
 
What used to be known as the “Damage Frequency Assessment” module is now separated into two methodologies based on the type of data you have: “Historic 
Damages” or “Professional Expected Damages.” These approaches are available for every hazard option. If your analysis is based on historic damage amounts 
and years with either known or unknown recurrence intervals, then you would use the “Historical Damages” method. If your analysis is based on damage 
estimates from a licensed professional with known recurrence intervals, then you would use the “Professional Expected Damages” approach.  
 
If you have both historic and expected damages, for example from a flooding event with known flood depths but no associated claims data, you should use the 
Historical Damages option and then enter the expected damages along with the appropriate recurrence interval(s) in the table with the historic damages. 
 
The Historic Damages and Professional Expected Damages approaches are the only options available for the Roads/Bridges and Utilities property types (with the 
exception of drought projects). See Figure 15 and Figure 16. For residential structures, non-residential structures, and critical facilities, you have to manually 
switch to these approaches. You would also use one of these approaches for projects mitigating hazards such as landslides, tsunamis, or winter storms. 
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Figure 15: Hazards available for Roads & Bridges using Historical Damages methodology 
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Figure 16: Hazards available for Utilities using Historical Damages methodology 
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Navigating the Tool 
 

Adding a Project 
 
Once you have opened the Toolkit window, you’ll see the Home screen. Click on “Add Project” to begin your analysis as shown in Figure 17. 
 

 
Figure 17: Adding a project 
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Enter your project title in the first field of the Project Configuration screen as shown in Figure 18. This will be your title for all the mitigation actions/structures in 
your project. Then enter your structure information. 
 

 
Figure 18: Project Configuration screen  
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Once you have entered your structure information and project costs, click “Next” to continue to the hazard analysis screen, as shown in Figure 19. 
 

 
Figure 19: Remainder of Project Configuration screen 
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Adding Comments 
 
To add a comment for any input field, click the comment box to the right of the field as shown in Figure 20. Then enter your comment in the comment box and 
click “Save” to close the window. 
 

 
Figure 20: Adding comments 
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If you want to enter your own input for a default value, for example the Building Replacement Value, click on the “Use Default?” toggle to switch it to “No.” See 
Figure 21. This will also unlock the comment box. 
 

 
Figure 21: Using non-default values 
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Be sure to enter a comment for all non-default values noting where the supporting documentation for that value can be found in the project application. See 
Figure 22. 
 

 
Figure 22: Using the comment box 
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The comment box will turn blue to indicate that you have entered a comment. See Figure 23. 
 

 
Figure 23: Comment boxes highlighted 
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Accessing the Help Content  
 
To access the help content, click the white “i” button on any card as shown in Figure 24. This will open a sidebar window with the help content. What 
information appears is dependent on the page of the Toolkit you’re on and the card you click on. 
 

 
Figure 24: Help content icon 
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Figure 25 shows the help content that appears for the Project Configuration screen. 
 

 
Figure 25: Help content window for Project Configuration screen 
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The Help content that appears on the Hazard Analysis screens differs from the Project Configuration screen. Clicking on the Help icons in these cards will open 
different sections of the Help content. 
 

 
Figure 26: Help content icons in Building Information and Standard Benefits - Building cards 
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The Help content for “Hazard Probability Parameters – Flood” opens when you click on the Help icon on that card. You can access the rest of the help content for 
that by clicking on the carrots on the right-hand side of the toolbar to expand or collapse the sections, as shown in Figure 27. 
 

 
Figure 27: Help content for "Hazard Probability Parameters – Flood" with expand/collapse carrots highlighted  
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Adding a Structure to a Project 
 
To add another structure or mitigation action to your project, click on the “Add Mitigation Action” button on the Project Summary screen as shown in Figure 28. 
This will open the Project Configuration screen for a new structure within that project. 
 

 
Figure 28: Adding a structure to a project 

 
  



Page 40 of 69 
 

Copying a Structure 
 
To copy a structure within a project, click the “Copy” button to the right of the structure BCR, as shown in Figure 29. 
 

 
Figure 29: Copying a structure 
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Deleting a Structure 
 
To delete a structure within a project, select the checkbox next to the structure you want to delete and click the “Delete Mitigation Actions” button, as shown in 
Figure 30. Make sure that you select only the structure(s) you want to delete. 
 

 
Figure 30: Deleting a structure 
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Viewing a Report 
 
To view the BCA report, select all the structures you want to include in your report and click “View Report” as shown in Figure 31. 
 

 
Figure 31: Viewing a report 
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Printing/Saving the Report 
 
To print or save the report, click “Print Report” at the top of the View Report screen as shown in Figure 32. 
 

 
Figure 32: Printing the report 
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To save your report as a PDF, select “Print to PDF” and click “Print.” 
 
Note: The Print Report function does not always work properly when using Excel for Mac. This issue will be addressed in the next release of the Toolkit. As a 
workaround, users may take a screenshot(s) of the Project Report page. 
 

Figure 33: Printing the report 
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Exporting a Project 
 
To export a project, select only the project(s) you want to export, then click “Export Projects” as shown in Figure 34. 
 

 
Figure 34: Exporting a project 
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This will open a download screen in Internet Explorer (see Figure 35). Click Save and select the location where the zip file should be saved, renaming the file if 
you prefer. You do not need to open the zip file. 
 
Note: The Export Projects function does not always work when using Excel for Mac. This issue will be addressed in the next release of the Toolkit. As a 
workaround, users may take a screenshot(s) of the Project Report page. 
 

 
Figure 35: Export zip file screen 
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Importing a Project 
 
To import a project, click the “Import Projects” button as shown in Figure 36. 
 

 
Figure 36: Importing a project 

 
This will open a side-bar window as seen in Figure 37. Click “Select File” to choose your zip file to import. 
 

 
Figure 37: Import project window  
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Select the zip file you want to import and click “Open” as shown in Figure 38. 
 

 
Figure 38: Import project selection on Windows machine 
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Click “Import” to import the file as seen in Figure 39.  
 

 
Figure 39: Importing a project - last step 
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The project will appear in the Home page with the date and time you imported it, as shown in Figure 40. 
 

 
Figure 40: Imported project on Home screen 
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The imported file will be locked so that you cannot make any changes to it, as seen in Figure 41. To make edits to an imported project, you must copy the 
project. 
 

 
Figure 41: Locked imported project 
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To copy a project, click the “Copy Project” button to the right of the project overview information on the Home screen, as shown in Figure 42. 
 

 
Figure 42: Copying a project  
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The copied project will have the date and time you copied it. If you copied an imported project, the copy will now be unlocked. 
 

 
Figure 43: Copied project on Home screen 
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You can edit the project title for copied projects in the Project Configuration screen for any structure. 
 

 
Figure 44: Editing the project title of a copied project 
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Deleting a Project 
 
To delete a project, select the checkbox next to the project you want to delete and then click “Delete Projects,” Make sure to select only the project(s) you want 
to delete, as shown in Figure 45. The tool will ask you if you are sure you want to delete the project and all associated data, as shown in Figure 45. If you want to 
delete the project, click “Yes” to permanently delete the project.  
 
 

 
Figure 45: Deleting a project 
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File Management 
 

Saving the File 
 
While the Toolkit calculations are performed within the add-in window, the data and projects themselves are stored within the Excel file. In order to save your 
projects once you have performed your BCA, you must:  

1. Click Finish on the Hazard Analysis screen. 
2. Close the add-in window. 
3. Save the Excel file. You can save the Excel file the same way you would any other Microsoft Office file, by using “Ctrl+S,” by navigating to File -> Save, or 

by using the AutoSave function in later versions of Excel. It is important to save early and often so as not to lose any data. 
 
Saving in Excel Online 
 
To save your work in Excel Online, you must do the following: 

1. Click Finish on the Hazard Analysis screen. 
2. Close the add-in window. 
3. Save a copy of the Excel file to your local machine by clicking File, Save As, Download a Copy, and choosing the “Open with Microsoft Excel” option. 
4. When the file opens in Excel, go to File, Save As, and save a copy to your local machine. 
5. To reopen the file in Excel Online, click “Upload a Workbook” in Excel Online and navigate to the file on your local machine. 
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Organizing Projects 
 
Because the Toolkit now works in Excel, you no longer have to store all your projects in the same database. Instead, you can now define your own file 
organization system. For example, you could save all BCAs from a specific disaster, subapplicant, or application cycle in its own file. 
 
To do this, you would go to “Save As,” name the file based on your preferred naming conventions (e.g. “DR-0000_Application_BCAs” or “FMA19_BCAs”), save 
the file in your preferred location, and then delete all unrelated projects from the file. 
 

Version Control 
 
The Toolkit automatically updates to the latest version as long as you are connected to the Internet when you reopen it. Because of this, the Toolkit implements 
version control when importing completed projects to ensure that your BCRs do not change if a standard value is updated. 
 
All imported projects are locked to prevent changes. To make any changes to your BCA, you will have to copy the original project. You can then edit the copied 
project. The original project will stay locked. 
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Frequently Asked Questions 
 

Getting Started 
 

1. I’m having trouble installing/opening the Toolkit. Where can I get help? 
 

The BCA Helpline can provide assistance with installation and launch issues. Email the Helpline at bchelpline@fema.dhs.gov or call 1-855-540-6744. 
 

2. Why can’t I open the add-in in another Excel spreadsheet? 
 

The add-in only works when opened in the FEMA-approved template. This ensures that no unauthorized changes can be made to the Toolkit or the 
calculations. 

 
3. How can I learn more about FEMA’s Benefit-Cost Analysis (BCA) process? 

 
To learn more about FEMA’s Benefit-Cost Analysis requirement, its methodology, available resources, training materials, or technical assistance, please 
visit www.fema.gov/benefit-cost-analysis. Updated training materials and BCA reference guide will also be posted here once they are finalized. 
 
For specific questions about doing a BCA, please email the BCA Helpline at bchelpline@fema.dhs.gov or call 1-855-540-6744. 
 

4. Why is my project grayed out when I open it? 
 

If you imported a project, it will be grayed out. This is intentional—because the Toolkit can automatically update values when you connect to the 
Internet, locking the project when it is imported ensures that someone sees the same BCA results regardless of what version they use or when they open 
the project. 
 
To edit the project, hit the “Copy Project” button on the home screen. You can now edit the copied project, including the project title, as needed. 

 
  

mailto:bchelpline@fema.dhs.gov
https://www.fema.gov/media-library/assets/documents/179903
http://www.fema.gov/benefit-cost-analysis
mailto:bchelpline@fema.dhs.gov
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General 
 

5. What should I do if I’m unfamiliar with a term or concept? 
 

If you come across an unfamiliar term or concept, the first place you should look is the Help content. The Help content is always signified by a white “i” 
in a blue circle. Clicking on this will prompt the tool to open a sidebar displaying the help content for that page. The help content is designed to be 
dynamic, so that different information appears depending on what page of the tool you’re on and which card you click on. 
 
If you have questions about how to perform an analysis, you can refer either to the training materials available on www.fema.gov/benefit-cost-analysis 
or by contacting FEMA’s Benefit-Cost Helpline at bchelpline@fema.dhs.gov. 
 

6. Can I still use v.5.3.0 if I want? 
 

Yes, you can continue to use v.5.3.0 to develop and submit BCAs for HMA projects through the end of the 2019 application cycle for PDM and FMA. 
FEMA will no longer update, fix, or support v.5.3.0, however, so we recommend that you transition to the new version sooner rather than later. 
 
The sole exception to this is for seismic structural and non-structural retrofits. FEMA is currently updating its seismic methodology, so users should 
continue to use v.5.3.0 for all seismic retrofit projects until the new methodology has been incorporated into v.6.0. You can, however, use v.6.0 for 
seismic infrastructure projects. 
 

7. Can I use the BCA Toolkit v.6.0 for a FEMA Public Assistance mitigation project? 
 

Yes. FEMA uses the same BCA methodology and software for both its Hazard Mitigation Assistance and Public Assistance programs. 
 

8. Where is the Damage Frequency Assessment module? 
 

The Damage Frequency Assessment (DFA) module is no longer a separate module within the Toolkit. Instead, it is now an analysis option contained 
within every hazard option. To use what was formerly known as the DFA, select either “Historical Damages” or “Professional Estimated Damages” as the 
damage frequency relationship option. If your analysis is based on past damages with known event years, select “Historical Damages.” If your analysis is 
based on probable damages with known recurrence intervals as estimated by a licensed professional, select “Professional Estimated Damages.” 
 

  

http://www.fema.gov/benefit-cost-analysis
mailto:bchelpline@fema.dhs.gov
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9. Can I upload my documentation into the Toolkit? 
 

No, Version 6.0 does not allow the user to upload or attach documents within the Toolkit. Any documentation or supporting information for your BCA 
should be uploaded into the project application intake system along with your project application. Use the comment box with each data field to refer the 
BCA reviewer to the appropriate document in your project application. 

 
10. Can I change a default value? 

 
Yes. With a few exceptions, such as project effectiveness for wildfire mitigation, you can change all default values in the Toolkit. Simply click on the 
Default Value toggle button to switch it from “yes” to “no.” This will unlock the input field so you can now type in your own value. You MUST make sure 
to provide a comment in the comment box, however, stating where you got that value and where the reviewer can find it in your application or 
supporting documentation (e.g. “See Project_Budget.pdf for project costs”). 
 

11. Can I import projects from v.5.3.0 into v.6.0? 
 

No, there is no way to export projects from v.5.3.0 to v.6.0. We therefore recommend that you not delete v.5.3.0 and that you make sure to save reports 
from past projects so that you can re-enter the data as necessary. 

 
12. How do I update the Toolkit? 

 
You don’t need to! As long as your computer is connected to the Internet, the Toolkit will update to the most recent version when you re-open it. If you 
are not sure if you have the current version, you can check the release notes available at this link. We publish release notes every time we make any 
substantial changes or updates to the Toolkit so that users know what has changed. 

 
  

https://www.fema.gov/media-library/assets/documents/179903
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13. Why isn’t the Export Projects function working? 
If you are using a Mac, this is a known issue and the software developers are working on a fix. As a workaround, you may email or share the Excel file or 
take a screenshot of the project report. 
 
If you are using a Windows operating system, check your taskbar for the View Downloads window, as shown in Figure 46. Sometimes the View 
Downloads window does not automatically appear. Your exported project should appear at the top of the list. 
 

 
Figure 46: View Downloads window in Windows 

 



Page 62 of 69 
 

14. Why doesn’t my BCR change when I change an input? 
 

Try clicking out of the input box. Sometimes the Toolkit does not update the BCR when you type in a new value. Clicking in another input box or 
elsewhere on the screen should cause the tool to re-calculate your BCR. If that still doesn’t work, try clicking “Finish” at the bottom of the page and then 
reopening that structure. You should now see the correct BCR. 
 

15. What should I do if I find an error in the Toolkit? 
 

If you find a calculation error, spelling error, or other type of mistake in the Toolkit, please send an email with a screenshot of the error to the Benefit-
Cost Helpline at bchelpline@fema.dhs.gov. The helpline staff will log the error and contact FEMA and the software developers so that they can fix it. 

 
 

Structure, Hazard, Mitigation Action, and Damage Frequency Relationship Options 
 

16. Why are some hazards grayed out? 
 

Version 6.0 has integrated the behind-the-scenes business logic in v.5.3.0 so that the hazard options that appear depend on a) the structure type 
selected for analysis and b) the analysis methodology. Instead of clicking through multiple screens to select the correct structure and analysis type, the 
Toolkit will only let users select certain combinations based on possible analysis options. For example, selecting “Roads & Bridges” as the structure type 
will make the analysis methodology default to “Historical Damages,” as these types of infrastructure projects always use service loss as the basis of 
analysis. When selecting a residential structure, the Toolkit defaults to modeled damages, although the user can switch to historical/professional 
estimated damages depending on the data they have. 
 

17. How do I select a hazard that’s grayed out? 
 

To select a hazard that’s grayed out, switch the damage-frequency relationship button from “Modeled Damages” to either “Historical Damages” or 
“Professional Estimated Damages” depending on the data you have. For example, if you would like to do a BCA for a landslide soil stabilization project on 
a residential structure, you would first select “residential” for structure type and then switch to “professional estimated damages.” This will allow you to 
select “landslide” as the hazard and then “soil stabilization” as the mitigation action. 

 
18. How do I do a BCA for a generator in v.6.0? 

 
The primary hazard that generators mitigate is loss of power. Power outages can be caused by multiple hazards, such as flooding or high winds. In order 
to do a BCA for a generator project, the recommended approach is to select the structure type, most likely “Critical Facility” or “Utilities,” and then 
select “Infrastructure Failure” as the hazard. If you selected “Critical Facility” for your structure, you will first need to switch the damage frequency 
relationship to either “Historical Damages” or “Professional Estimated Damages” in order to select “Infrastructure Failure” as the hazard. Whether you 

mailto:bchelpline@fema.dhs.gov
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select Historical or Professional Estimated Damages depends on the type of data you have to document your damages. The mitigation action will then be 
“other.” 

 
19. How do I do a hurricane wind retrofit or a hurricane safe room for a critical facility? 

 
To do a BCA for a hurricane safe room for a critical facility, you have to select “Non-Residential Building” as the structure type and then select “Hurricane 
Safe Room” as the hazard. This is because the benefits are not based on loss of service of the facility but loss of life of the people inside the safe room. 
 
When conducting a BCA for a hurricane wind retrofit of a critical facility, there are two options for how to analyze the benefits. Which one is appropriate 
depends on whether the project will reduce physical damages to the building or loss of service. If the project primarily reduces physical damages and/or 
loss of function resulting from the physical damages, then the user should select Non-Residential Building for the structure type and use the modeled 
damages approach. If the project’s loss of service reduction is primarily based on reduced service down time instead of improved building performance, 
then the user should select “Critical Facility” as the structure type and use the historical or professional expected damages approach.  

 

Reports 
 

20. How do I save or print my report? 
 

To save or print your BCA report, select the structures you want included in your project on the “Project Summary” screen and then click “View Report” 
to open the report. At the top of the screen, click “Print Report.” This will open up a print window. From here, you can either select “Print to PDF” to 
save your report as a PDF or you can print the report directly. 

 
21. Why can’t I print the report or export projects on a Mac? 

 
There is a known issue with v.6.0 that sometimes the “Print Report” and “Export Project” functions do not work when using Excel for Mac. The software 
developers are currently working on a fix for this issue, which will be included in the next update of the Toolkit. 
 
For now, Mac users can take screenshots of their reports and share the Excel spreadsheet file via email or document upload as workarounds for these 
issues. 
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Appendix A: Installation Instructions 
 

Excel desktop (Non-FEMA machines) 
 

1. Download the .xlsx file at this link and open it. 
2. In the Insert tab, in the Add-ins section, click on My Add-ins. 
3. With My Add-ins selected, click on the Office Store button. 
4. In the Office Store, search for “FEMA Benefit-Cost Analysis Calculator.” Click Add. 
5. You should now see the FEMA BCA V6.0 icon in the upper righthand ribbon in the Home tab. 
6. To launch the Toolkit, click on the FEMA BCA button. A sidebar will open. 
7. Click Open Calculator to begin your BCA. 
8. The add-in window will open and take you to the Home screen. From here you can start a new project by clicking Add Project. 
9. To save your work, click “Finish” on the second screen, and save the Excel file, renaming it if desired. 

 

Excel desktop (FEMA machines) 
 

1. Download the .xlsx file at this link and open it. 
2. In the Insert tab, in the Add-ins section, click on My Add-ins. 
3. With Admin Managed selected, click on FEMA Benefit-Cost Analysis. 
4. You should now see the FEMA BCA V6.0 icon in the upper righthand ribbon in the Home tab. 
5. To launch the Toolkit, click on the FEMA BCA V6.0 button. A sidebar will open. 
6. Click Open Calculator to begin your BCA. 
7. The add-in window will open and take you to the Home screen. From here you can start a new project by clicking Add Project. 
8. To save your work, click “Finish” on the second screen, close add-in window, and save the Excel file, renaming it if desired. 

  

https://www.fema.gov/media-library/assets/documents/179903
https://www.fema.gov/media-library/assets/documents/179903
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Excel Online 
 
If using a FEMA machine, you will need to use Firefox as your browser. 
 
Important Note: You must make sure to save a copy of the file to your local machine once you have closed the add-in window. You may do this by clicking File, 
Save As, Download a Copy, and choosing the “Open with Microsoft Excel” option. Once the file opens, click File, Save As, and save a copy to your local machine. 
 

1. Download the .xlsx and .zip files (the first two files) at this link and save them to your machine. You will need to unzip the .zip file. 
2. If you don’t already have one, set up an Office 365 account at https://www.office.com/. This is free to set up.  
3. Once logged in, open Excel Online by clicking on the Excel icon under Apps. 
4. Open the file BCA_Toolkit_6.xlsx in Excel Online by clicking Upload a Workbook or Upload and Open. 

 
Figure 47: Excel Online main screen (may look different depending on Office 365 account type and browser) 

5. In the Insert tab, click Office Add-ins. 

https://www.fema.gov/media-library/assets/documents/179903
https://www.office.com/
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Figure 48: BCA Toolkit 6.0 launch screen in Excel Online 

 
6. Click on the Upload My Add-in link. 

 
Figure 49: Office Add-ins window in Excel Online 
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7. Browse to where the unzipped .xml file was saved, select it, and click open. 
8. You should now see the FEMA BCA V.6.0 button in the top righthand side. 

 
Figure 50: BCA Toolkit 6.0 button in Excel Online 
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9. To launch the Toolkit, click on the FEMA BCA button. A sidebar will open. 

 
Figure 51: BCA Toolkit 6.0 sidebar in Excel Online 
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10. Click “Open Calculator.” You may be asked if you want to allow your browser to open another window. Click Allow. 

 
Figure 52: Pop-up window asking if you want to allow your browser to open another window 

 
11. The add-in window will open and take you to the Home screen. From here you can start a new project by clicking Add Project. 
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